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Common Questions & Answers
This gives a list of commonly asked questions with their answers.

Introduction



Starting dbsPay2
To start dbsPay2 under Windows:

1. Ensure that you are running Windows.
2. Double click the dbsPay2 icon in the dbsPay2 program group or choose the Run 

command from the File menu and type the path name e.g. C:\DBSPAY2\
DBSPAY2.EXE.

3. The login window is shown. Enter your user id and password and click the Login 
button. If they are entered correctly then the main menu is shown.

To start dbsPay2 under Macintosh System 7:
1. Double click the dbsPay2 icon in the dbsPay2 folder.
2. The login window is shown. Enter your user id and password and click the Login 

button. If they are entered correctly then the main menu is shown.

The title for the dbsPay2 application window indicates which company is currently being 
worked upon. This allows multi-company payrolls to be managed by dbsPay2 for payroll 
bureau operations. If you are running the single company version then this title will remain 
the same as you will only work with one company. 



Main Menu
The title for the dbsPay2 application window indicates which company is currently being 
worked upon. This allows multi-company payrolls to be managed by dbsPay2 for payroll 
bureau operations. If you are running the single company version then this title will remain 
the same as you will only work with one company. 
When the application is started the top of the screen contains the main menu. The main 
menu contains the following:
Related Topics:

dbsPay2
Employer
Employee
Tools
Reports



dbsPay2
About dbsPay2 Shows the version number and other details.
Login To logout and allow someone else to login.
Tidy Checks the database and recovers any unused disk space due 

to deleted information.
Import To transfer payroll information from other Deverill Business 

Systems payroll products when upgrading to dbsPay2.
Backup Takes a copy of your files to either diskette or hard disk
Restore Replaces files from backup diskettes or hard disk.
Users Allows details of user id and passwords to be maintained. Use 

the View command to see a list of users or the Add command to
add a new user.

Exit/Quit Used to quit the program.



Employer
Employer View the currently selected employer details or add a new 

employer
Additions View pay addition details
Bank View company bank details
Cash View coin analysis details
Deductions View pay deduction details
Departments View the departments
GL Accounts Views GL account codes by department
IR Returns View the Inland Revenue returns
National Insurance View the national insurance rates for employer and employee
Pay View pay parameter details
SSP & SMP View the Statutory Sick Pay and Statutory Maternity Pay rates
Tax View the tax table
Select Employer Change the employer/company to work with (payroll bureau 

operations)



Employee
Add Add a new employee
View by ID View a list of employees in payroll identifier sequence
View by Surname Views a list of all employees in surname sequence
View by Forename Views a list of all employees in forename sequence
View by Work No Views a list of employees by Works number
View by Dept Views a list of employees in department sequence
View by Icon Use this command to toggle the view between being graphical 

and a normal list style. If the command is ticked the view will be
graphical when you choose one of the View by commands



Tools
Pay All... Inputs pay details and calculates the pay for all employees in 

the selected sequence (id, surname, work number or 
department)

Pay Department... Inputs pay details and calculates pay for a selected department
Pay Employee... Inputs pay details and calculates pay for an individual
Close Pay Period... Closes the pay period
Post to GL... Generate an ASCII    posting file or printed report
View Holidays... View details of employee holidays
View SSP... View details of SSP absence 
View SMP... View details of SMP absence
Initiate SMP... Initialise SMP details for future SMP payments
Amend Tax Codes... Bulk tax code changes for all employees
Class 1A NIC Input of Class 1A NIC details for employees with company cars
Amend NI... Allows an NI refund or deduction to be made
NIC Holiday... Allows NIC Holiday to be initiated for a qualifying employee
End of Year... End of year processing for all employees
Pay Review... Allows percentage increases to be applied to employees pay 

additions
Automatic IDs Allows you to specify whether employer, employee and 

department IDs are automatically generated
Security Levels Allows the security levels for commands to be altered



Reports
Print... Prints the reports to a printer
View... Views previous reports stored on disk



Setting up Users
To gain access to dbsPay2 you have to supply a valid user id and password.
Users are assigned a security level which enables you to limit which commands can be 
performed by various users. This can be useful in situations where several people are 
allowed access to the payroll but certain operations are not allowed to be performed, e.g. 
calculating the pay. In addition to functional security, each individual employee can have a 
security access level defined. This can be used to prevent users access to particular 
individuals' data, e.g. directors.
You should decide who is going to operate the payroll and what level of access each user 
should have. If you only have one person using the payroll then you should set them up with
a security level of 5 (highest) which allows access to all functions and employees. Individual 
users can access and amend their user details held, for instance to change a password.
You can have as many users defined as you wish, but you may only have as many 
simultaneous users accessing dbsPay2 as you have purchased licences for.
Choosing Users and then View from the dbsPay2 menu shows a list of users defined to the
system. The following information is shown:
User Id Eight character user id
Password Six character encrypted password
Expiry Date Expiry date of the password
Level The security level assigned for this user
Related Topics:

To add a new user
To amend an existing user
To delete a user
User Detail Window
Security Levels



To add a new user
1. Click the right mouse button when viewing the list of users or choose the Users Add 

command from the dbsPay2 menu.
2. The User Detail window is shown. If you were viewing a list press the New button.
3. Enter the details and click the Save button.
4. Click the Close button.



To amend an existing user
1. Select the user to be amended.
2. Click the right mouse button.
3. The User Detail window is shown.
4. Click the Amend button.
5. Enter the changes.
6. Click the Save button.
7. Click the Close button.



To delete a user
1. Select the user to be deleted.
2. Click the right mouse button.
3. The User Detail window is shown.
4. Click the Delete button.
5. Confirm the deletion by clicking the Yes button.



User Detail Window
The following information is shown:
User Id Up to 8 characters to identify the user
Password Up to 6 characters. The password will be encrypted for you on saving the 

details
Expiry Date Expiry date of the password 
Security Level Choose a number between 1 and 5.    Level 5 allows access to everything and

at least one user must be defined with this level
The following buttons are available:
New To add a new user
Amend To alter the details shown
Delete To delete the user shown
Close To close the window
Save To save any changes made
Cancel To ignore any changes made.
Related Topics:

To add a new user
To amend an existing user
To delete a user



To add a new user
1. Click the New button
2. Enter the details and click the Save button.
3. Click the Close button.



To amend an existing user
1. Click the Amend button.
2. Enter the changes.
3. Click the Save button.
4. Click the Close button.



To delete a user
1. Click the Delete button.
2. Confirm the deletion by clicking the Yes button.



Security Levels
Security levels for functions are pre-allocated when you purchase your dbsPay2 system, but 
can be amended.
Employees are individually assigned a security level of those allowed to view their details, 
pay them etc. These persons will not appear in reports unless you have at least the security 
level specified in the Personnel details.



Adding a new company
To add a new company then choose the Employer command in the Employer menu.
The following information is shown:
Employer Id Company short name
Name Company name
Address Company address
Telephone Telephone number
Facsimile Facsimile number
PAYE Reference Quoted on all Inland Revenue correspondence
PAYE District Number Quoted on all Inland Revenue correspondence
Icon Style Select the type of icon to be used when viewing employees by 

icon

The following buttons are available:
New To add a new employer
Amend To change the employer details shown
Delete To delete the employer details
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information



Changing to another company
dbsPay2 multi company version allows you to run the payroll for several companies, thus 
being suitable for a payroll bureau operation.
The commands apply to the currently selected company as shown in the title bar of the 
window. 
Related Topics:

To work with dbsPay2 for another company



To work with dbsPay2 for another company
1. Choose the Select Employer command from the Employer menu.
2. The Select Employer window is shown.
3. Select the company you require from the list box.
4. Click the Select button to select the company to work with or click the Cancel 

button to remain with the current company. Click the Remember button to 
automatically select the company to work with when dbsPay2 is started.



Terminating dbsPay2
To quit the program choose the Exit command (Windows users) or the Quit command 
(Macintosh users) in the dbsPay2 menu. If you just wish to logout, choose the Login 
command from the dbsPay2 menu.



Backup & Restore
It is vitally important to keep backup copies of your work. Imagine the problems you would 
face if you were unable to pay your employees at the correct time! To avoid this happening 
you must make regular copies of your work. 
The Backup command is available in the dbsPay2 menu. Whenever you quit dbsPay2 by 
selecting the Exit command from the dbsPay2 menu, you will be alerted if important 
information has changed and you have not used the backup command to take a copy of your
work.
Backing up your data involves making a copy of your working information so that, if you 
need to, you can recover back to a known position. We suggest that you copy your work 
after each payroll run, rotating a minimum of three diskettes. 
By using this method, whatever happens whilst you are running dbsPay2, you will be able to 
go back at least two weeks/months prior to a problem. You need to backup onto a medium 
that is removable and storable away from the computer in case of computer malfunction, 
fire etc.
A backup and restore log is automatically kept for you.
Related Topics:

To backup your data
To restore your data from a backup copy



To backup your data
1. Choose the Backup command in the dbsPay2 menu.
2. To backup to hard disk enter the path name and a suitable remark e.g. after creating 

employees. To backup to floppy disk enter your diskset no and remark. 
3. If you wish to backup all employers (multi-company version) then ensure the Current 

Employer only check box is blank. You would normally backup just the employer you 
are currently working with. Click the Proceed button to commence the backup or to 
abort the backup, click the Cancel button.

4. If backing up to floppy disk, insert the requested floppy disk and click the OK button.
5. The backup will display messages as it progresses and on completion will display 

'Backup completed'.
6. You will be returned to the Backup window. You can see the log by clicking the Log 

button. The Tidy Log button will remove old entries from the log. To close the 
window click the Cancel button.

The following events are some that would require you to restore from your backup disks:
Power failure during a pay run
System crashes during a pay run
Hardware failure during a pay run
Corrupted files

In order to restore your data you will need to copy your backed up files back onto the disk or
disks they were copied from. You should record any restoration of data in your backup log.



To restore your data from a backup copy
1. Choose the Restore command in the dbsPay2 menu.
2. To restore from hard disk enter the path name and a suitable remark    e.g. power 

failure. To restore from floppy disk enter your diskset no and remark. 
3. If you wish to restore all employers (multi-company version) then ensure the Current 

Employer only check box is blank. You would normally restore just the employer you 
are currently working with. Click the Proceed button to commence the restore or to 
abort the restore, click the Cancel button.

4. If restoring from floppy disk insert the requested floppy disk and click the OK button.
5. The restore will display messages as it progresses and on completion will display 

Restore completed'.
6. You will be returned to the Restore window. You can see the log by clicking the Log 

button. The Tidy Log button will remove old entries from the log.To close the window
click the Cancel button.

If you incorrectly pay someone, then you will not necessarily have to use the restore facility 
and repay all your staff unless you have closed the pay period. 



Queries
An attempt has been made to answer some of your questions in the Common Questions & 
Answers section, see Common Questions & Answers. It is therefore suggested that before 
contacting Deverill Business Systems for help you review that section.
If you are unable to resolve your problem and you have registered your copy of dbsPay2 with
us, please contact Deverill Business Systems. Refer to your Customer Support Programme 
which accompanied the package for details on how to contact Deverill Business Systems for 
help. When corresponding with DBS state your dbsPay2 serial number and describe the 
problems you are experiencing. If we are unable to quickly resolve your problem we may ask
you to send a copy of your data and program diskette to us for further investigation.
Provided that the level of service required is covered by your Customer Support Agreement   
then there will be no additional charge for this service, otherwise you will be given a no 
obligation quotation of the costs involved before your query is investigated.



Company Tables Overview
For multi-company users, ensure that you have the correct company to work with before 
viewing the tables. The company name is shown in the title bar of the main window. 
The Employer menu has the commands that are used to view and modify tables:
Employer View the currently selected employer details or add a new 

employer
Additions View pay addition details
Bank View company bank details
Cash View coin analysis details
Deductions View pay deduction details
Departments View the departments
GL Accounts Views GL account codes by department
IR Returns View the Inland Revenue returns
National Insurance View the national insurance rates for employer and employee
Pay View pay parameter details
SSP & SMP View the Statutory Sick Pay and Statutory Maternity Pay rates
Tax View the tax table
View Change the employer/company to work with (payroll bureau 

operations)



Addition Names
Choose the Additions command in the Employer menu to view the addition names 
together with their settings for payroll calculation purposes. These names are used to make 
up the payment entries in the employees current and year to date details and subsequently 
the payslip and other reports. 
Up to fifteen names can be specified, each name being up to 20 characters long. 
The following information is shown:
Name The pay addition descriptive name
Pre tax Mark the check box if payment is made before tax is calculated, leave blank 

if payment is allowed against tax
Pre NI Mark the check box if payment is made before National Insurance is 

calculated, leave blank if payment is allowed against NI
Pension Mark the check box if the payment is used to calculate the pension 

contribution, leave blank if payment is not used
Zero Mark the check box if the payment should be cleared before input of pay 

details and subsequent payroll calculation
Calc Mark the check box if the payment is calculated by multiplying a quantity 

and a rate e.g. overtime.
Always Mark the check box if the item is to appear in every new employees current 

pay period information.
The following buttons are available:
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Related Topics:

To alter the pay addition details
To close the window



To alter the pay addition details
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Company Bank Details
Choose the Bank command in the Employer menu to view the company bank details. This 
information is used when printing bank giro credits and other automated payment schemes.
The following information is shown:
Bank name
Branch name
By order of
Autopay National Westminster Bank scheme
    Branch Name
    Account Number
BOBS Barclays Branch Originated BACS Service
    Customer No
    Application No
    Account Type
    Transaction Code
The following buttons are available:
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Related Topics:

To alter the bank details
To close the window



To alter the bank details
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Coin Analysis Details
Choose the Cash command in the Employer menu to view the coin analysis details. This 
information is used when printing the coin analysis report. Select the denominations 
required by setting the check boxes.
The following buttons are available:
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Related Topics:

To alter the coin analysis details
To close the window



To alter the coin analysis details
1. Click the Amend button.
2. Mark the check boxes for those denominations required to be used when paying staff 

by cash.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Deduction Names
Choose the Deductions command in the Employer menu to view the deduction names 
together with their settings for payroll calculation purposes. These names are used to make 
up the deduction entries in the employees current and year to date details and subsequently
the payslip and other reports.
Up to fifteen names can be specified, each name being up to 20 characters long.
The following information is shown:
Name The pay deduction descriptive name
Pre tax Mark the check box if deduction is made before tax is calculated i.e. it is 

allowed against tax, leave blank if deduction is not allowed against tax
Pre NI Mark the check box if deduction is made before National Insurance is 

calculated, leave blank if deduction is not allowed against NI
Pension Mark the check box if the deduction is allowed against the amount used to 

calculate the pension contribution, leave blank if deduction does not alter 
the pension calculation

Zero Mark the check box if the deduction should be cleared before input of pay 
details and subsequent payroll calculation

Reduce Mark the check box if the deduction is a reducing balance type deduction 
where you can specify a starting balance and have the balance reduce each 
pay period

Always Mark the check box if the item is to appear in every new employees current 
pay period information.

The following buttons are available:
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Related Topics:

To alter the pay deduction details
To close the window



To alter the pay deduction details
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Department Details
Choose the Department View command in the Employer menu to view a list of 
departments previously entered. This information is used during reporting to print 
department names and also to group employees by department for reporting purposes.
The following information is shown:
Department Id Department code
Name Department name
Related Topics:

To view or amend a department
To delete a department
To add a new department



To view or amend a department
1. Select the department by positioning on the appropriate row.
2. Click the right mouse button.
3. The Department Details window is shown.



To delete a department
1. Select the department you require by positioning on the department in the list using 

the scroll bars where necessary.
2. Having selected the department by pressing the left mouse button in any of the 

columns shown for the department, click the right mouse button to show the detail.
3. The Department Details window is shown.
4. To delete the department, click the Delete button.



To add a new department
1. Choose the Department Add command from the Employer menu or click the right 

mouse button whilst viewing departments.
2. The Department Details window is shown. If you were viewing a list press the New 

button.
3. Enter your department code and name. The code is used when entering employee 

details.
4. Click the Save button to keep your changes or the Cancel button to ignore.
5. Repeat steps 3 and 4 for each department to be added.
6. Click the Close button to close the window.



Department Detail Window
The following information is shown:
Department Id Department code
Name Department name
The following buttons are available:
New To add a new department
Amend To change the information shown.
Delete To delete the department shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Related Topics:

To add a new department
To alter the department details
To delete a department
To close the window



To add a new department
1. Click the New button and enter your department code and name. The code is used 

when entering employee details.
2. Click the Save button to keep your changes or the Cancel button to ignore.



To alter the department details
1. Click the Amend button whilst the Department Details window is shown.
2. Enter the change to the name.
3. Click the Save button to keep your change, or the Cancel button to ignore.



To delete a department
1. Click the Delete button whilst the Department Details window is shown.
2. Confirm the deletion by clicking the Yes button. 



To close the window
1. Click the Close button.



GL Account Codes
Choose the GL Accounts command in the Employer menu to view the General Ledger 
Account details. This information is used during the calculation of pay and subsequent 
printing of the GL Postings report. 
General ledger accounts can be allocated on a department basis to allow for a departmental 
breakdown of postings on a general ledger, or just on a company basis, as determined by 
the check box shown on the Employer Pay Details window.
 If you are using the departmental basis, ensure that you have set up your departments 
before you wish to enter your GL account codes. If using a departmental basis then a list of 
departments from which you can select the ones to be viewed is shown. 
The following information is shown:
Department Id Department code
Name Department name
Related Topics:

To view or amend a department's GL accounts



To view or amend a department's GL accounts
1. Select the department by positioning on the appropriate row.
2. Click the right mouse button.
3. The GL Accounts window is shown.



GL Accounts Window
This shows descriptions of each transaction that will be used during posting and you can 
enter your account code against the description. Specifically excluded will be self 
compensating items within the expenses section of the General Ledger.
You will be shown following:
Liability Accounts
Tax Paid
National Insurance (total)
Net Pay
Pension employee
Pension employer
COMP
If the Tax paid and National Insurance are given the same account number then a Due to 
Exchequer account is effectively used. If the pension accounts, i.e. last three liability 
accounts, are given the same account number then a due to pension fund account would be 
used.
Expense Accounts
Additions Each pay addition name that you are using
Deductions Each pay deduction name that you are using
Rounding
SSP Non recoverable
SMP Non recoverable
NI Employer
NIC SMP
Pension employer
COMP
If different account numbers are used then the greatest flexibility exists. If the expense 
accounts are all given the same number then a cost of employees account is effectively 
used.
The following buttons are available:
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information
Prev Displays the GL Account codes for the previous department if the GL is 

broken down by department
Next Displays the GL Account codes for the next department if the GL is broken 

down by department



Related Topics:
To alter the department's GL account details
To close the window



To alter the department's GL account details
1. Click the Amend button whilst the GL Account window is shown.
2. Enter the GL account codes for each description shown.
3. Click the Save button to keep your changes, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Inland Revenue Returns
Choose the IR Returns command in the Employer menu to view the Inland Revenue 
returns details. This is a summary of the returns your company needs to make to the Inland 
Revenue and details the entries in your payslip booklet. It is used to print the Inland 
Revenue returns report.
The following information is shown for each returns period:
SSP Recovered Amount of SSP recovered
SMP Recovered Amount of SMP recovered
NIC Comp SMP National insurance compensation on SMP
NIC Holiday NIC Holiday recovered
Tax Income tax
Gross NI Total of National insurance for employee and employer
NI Gross NI less any Class 1A National insurance
SSP Paid Amount of SSP paid, used to calculate the SSP recovery amount.
The following buttons are available:
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Calc SSP Re-calculate the SSP Recoverable. Not usually used as the SSP recoverable is

always recalculated during pay calculations.
Related Topics:

To alter the Inland Revenue Returns details
To close the window



To alter the Inland Revenue Returns details
1. Click the Amend button.
2. Enter your changes
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



National Insurance Rates
Choose the National Insurance command in the Employer menu to view the national 
insurance details for the employer.
The following information is shown in columns:
Earnings Limits The earnings limits for the percentages shown in the column
Contracted In %
Standard % rate for NI letter A employees for this earnings band
Reduced % rate for NI letter B employees for this earnings band
Emp'er only % rate for NI letter C employees for this earnings band
Contracted Out Salary Related Schemes %
Standard % rate for NI letter D employees for this earnings band
Reduced % rate for NI letter E employees for this earnings band
Emp'er only % rate for NI letter Z (officially letter C contracted out) employees for this 

earnings band
Contracted Out Money Purchase Schemes %
Standard % rate for NI letter F employees for this earnings band
Reduced % rate for NI letter G employees for this earnings band
Emp'er only % rate for NI letter S employees for this earnings band

The following buttons are available:
Employer Displays the employer NI rates
Employee Displays the employee NI rates
Amend To change the information shown.
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information.
Related Topics:

To alter the NI rates employee details
To alter the NI rates employer details
To close the window



To alter the NI rates employee details
1. Click the Employee button.
2. Click the Amend button.
3. Enter your changes
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To alter the NI rates employer details
1. Click the Employer button.
2. Click the Amend button.
3. Enter your changes
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Pay Parameters
Choose the Pay command in the Employer menu to view the pay calculation details. These
details influence the payroll calculation for all employees.
The following information is shown:
No of Decimals Select the appropriate radio button for the number of decimal 

places of a penny to be used for calculate type pay addition 
fields.

Rounding of Net pay Select the appropriate radio button to specify your rounding. If 
no rounding required set it to 1p.

Round net pay down Mark the chcek box if rounding is to be done down to the 
smallest denomination, i.e. if round to nearest £1 and pay 
£104.76, then actual pay will be rounded down to £104 if the 
check box is marked, or rounded up to £105 if left blank. Any 
under or over payment will be adjusted in the next pay run.

Tax refund new employee Maximum tax refund allowed for a new employee.
K code max tax deduction %The maximum percentage of employees pay that may be 

deducted in a single pay run if on a K tax code.
COMP rebate employee % Contracted out money purchase schemes rebate % for an 

employee.
COMP rebate employer % Contracted out money purchase schemes rebate % for an 

employer.
Deduct rebate from earnings Mark the check box if the COMP rebate is to be deducted

from employee earnings, otherwise leave blank.
GL by Department Mark the check box if you wish the GL posting to be broken 

down by department, leave blank if only company totals are 
required.

The following buttons are available:
Amend To change the information shown
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information
You should set the number of decimal places for calculate type pay addition fields before you
add your employees. If you amend this setting after employees have been entered then 
check that the correct rates are shown for each employee.
The rounding field may be altered at any time and will have an immediate effect for future 
pay calculations. However, if the rounding field is set back to 1p, after already using the 
rounding to some higher denomination, the rounding entries in the employee records will 
remain for the rest of the current tax year. The employee would in this circumstance be 
refunded/deducted any residue rounding amount held in the next pay run. 
If you are rounding and an employee leaves, then the final payment will not refund/deduct 
any residue rounding amount at this would result in an odd amount being paid. If you wish to
refund/deduct the residue amount then refer to Rounding in the Queries section.
Related Topics:



To alter the Pay Parameter details
To close the window



To alter the Pay Parameter details
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Tax
Choose the Tax command in the Employer menu to view the tax table details. 
The following information is shown in columns:
Basic Rate Set this radio button to the tax band that will be used for basic 

rate tax payers , i.e. BR tax code.
Bandwidth The bandwidth amount to be used at the % rate shown. 
% Rate The tax rate to be applied to the bandwidth.
The following buttons are available:
Amend To change the information shown
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information
Related Topics:

To alter the Tax table
To close the window



To alter the Tax table 
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Company SSP and SMP
Choose the SSP & SMP command in the Employer menu to view the SSP and SMP rate 
details. 
The following information is shown:
Small Employer Mark the check box if the employer is classed as a small 

employer. 
SSP earnings limit
      Amount SSP earnings limit amount before which SSP is payable.
      Rate The SSP amount payable.
Max SSP weeks in a PIW The maximum number of weeks SSP is payable in a period of 

incapacity to work.
SSP Reimbursement % The % rate to apply to the National Insurance contributions 

(employee and employer excluding Class 1A) for an Inland 
Revenue returns period.

Max SMP weeks in a MPP The maximum number of weeks SMP is payable in a maternity 
pay period.

SMP NIC Compensation % The % rate of National Insurance compensation on SMP 
payments.

SMP Recovery Rate % The percentage rate which determines the SMP amount to be 
recovered. 

SMP Lower Rate The lower rate of SMP payable.
The following buttons are available:
Amend To change the information shown
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information
Related Topics:

To alter the SSP & SMP table
To close the window



To alter the SSP & SMP table 
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Employee Views
Modifying existing employee details and the entry of new employee details are carried out 
using up to seven windows to show all the information held about an employee:

Personnel window
Bank window
Payroll General window
Current Pay Period window
Year to Date window
NI and Pension window
SSP & SMP window

The Employee menu contains commands that enable you to view and amend your 
employees:
View by ID View a list of employees in payroll identifier sequence
View by Surname Views a list of all employees in surname sequence
View by Forename Views a list of all employees in forename sequence
View by Work No Views a list of employees by Works number.
View by Dept Views a list of employees in department sequence.
View by Icon Use this command to toggle the view between being graphical 

and a normal list style. If the command is ticked the view will be
graphical when you choose one of the View by commands. The 
icon style is set in the Employer window.

Related Topics:
Viewing employees as a list window
Viewing departments as an icon window
Viewing employees as an icon window



Viewing employees as a list window
When viewing employees in the list style the following columns are shown:
Surname
Forenames
Title
Employee ID
Department
Work No
Paid to period The last tax week or month paid to.
Pay Frequency Weekly, Fortnightly, 4 Weekly, Monthly
Related Topics:

To add a new employee
To view or amend details held for an employee



To add a new employee
1. Choose the Add command from the Employee menu or click the right mouse button 

whilst viewing employees.
2. The employee personnel details window is shown. If you were viewing a list press the 

New button.



To view or amend details held for an employee
1. Select the employee by using the arrow keys or scroll bars to position on the desired 

employee. Click in one of the columns for the employee and then click the right 
mouse button.

2. The Personnel Details window is shown.



Viewing departments as an icon window
When viewing by department in an icon style, each department is represented by a folder. 
The following buttons are available:
Page Up To see the previous set of departments
Page Down To see the next set of departments
Close To close the window
Add To add a new department
View By Select the radio button to determine the order employees are shown in.
Related Topics:

To view employees for a particular department
To add a new department



To view employees for a particular department
1. Use the Page Up and Page Down buttons until the department can be seen. 
2. Click on the department.



To add a new department
1. Click the Add button.
2. The department detail window is shown.



Viewing employees as an icon window
When viewing employees in the icon style, each employee is represented by a man or 
woman graphic. The Employer window allows you to choose the icon style used. If they have
a sad face then they have had the date of leaving set. They will be shown in the order 
selected by the view by command.
The following buttons are available:
Page Up To see the previous set of employees
Page Down To see the next set of employees
Close To close the window
Add To add a new employee
Related Topics:

To view or amend details held for an employee
To add a new employee



To view or amend details held for an employee
1. Use the Page Up and Page Down buttons until the employee can be seen. 
2. Click on the employee.



To add a new employee
1. Click the Add button.
2. The employee personnel details window is shown.



Employee Personnel Details
This window is used to view and modify the personnel details for an employee. It also allows 
access to all the other details held for the employee via the buttons.
The following information is shown:
*Employee ID Can be automatically assigned see Automatic IDs in the Tools 

menu or you could manually enter a unique identifier to be 
assigned for payroll purposes.

*Security Level The security level number of users who are allowed to see this 
employee's details, between 1 (lowest) to 5 (highest). If set to 1
all users will be able to view, if set to 3 then only levels 3, 4 and
5 users can view.

*Surname
*Forenames
*Title
Address The employee's home address.
Post code The postcode for the employee's address.
Date of birth Date of birth in format DD/MM/YY, e.g. 21/02/50.
Date started Date employment started with you.
Date left Date employment ceased with you.
Telephone The telephone number.
*Male Mark the check box if male, leave blank if female
*Director Mark the check box if a director, leave blank if not
Marital Status Choose the appropriate radio button to choose the marital 

status.
Other Details These allow additional personnel details to be entered, e.g. 

qualifications, pay review dates etc.
Holiday Entitlement Number of days holiday entitled to in a company year.
Holidays Taken Number of days holiday taken
Holidays left Number of days holiday left.                                                                           
* indicates the minimum entries needed for a new employee
The following buttons are shown:
New To add a new employee
Amend To change the personnel details shown
Delete To delete the employee details
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information
Bank To view the bank and Autopay/Bobs details



Pay To view the payroll general details
Period To view the current period details
Year To view the year to date details
NI To view the National Insurance and Pension details
SSP To view the statutory sick pay and statutory maternity pay details
 
Related Topics:

To amend the personnel details
To add a new employee
To amend the bank details
To amend the payroll general details
To amend the current period details
To amend the year to date details
To amend the NI and Pension details
To amend the SSP and SMP details
To close the window



To amend the personnel details
1. Click the Amend button.
2. Enter your changes.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.



To add a new employee
1. Click the New button.
2. Enter the personnel details.
3. Click the Save button to keep your amendments, or the Cancel button to ignore.
4. You will be led through the other windows associated with the buttons at the bottom 

right to add the other information.



To amend the bank details
1. Click the Bank button to alter bank details.
2. The Employee's Bank Window is shown.
3. Click the Amend button and enter your changes.
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To amend the payroll general details
1. Click the Pay button to alter general payroll details.
2. The Employee's Payroll General Window is shown.
3. Click the Amend button and enter your changes.
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To amend the current period details
1. Click the Period button to alter current pay period details.
2. The Employee's Current Pay Period window is shown.
3. Click the Amend button and enter your changes.
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To amend the year to date details
1. Click the Year button to alter year to date details.
2. The Employee's Year to Date window is shown.
3. Click the Amend button and enter your changes.
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To amend the NI and Pension details
1. Click the NI button to alter NI and Pesion details.
2. The NI and Pension window is shown.
3. Click the Amend button and enter your changes.
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To amend the SSP and SMP details
1. Click the SSP button to alter SSP and SMP details.
2. The Employee's SSP and SMP window is shown.
3. Click the Amend button and enter your changes.
4. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Bank Details
The Bank Details window shows bank information if you are paying by giro credit, autopay or
Bobs.
The following information is shown:
Bank Account No The bank account number or building society's bank account number 

for this employee
Sort Code Bank or Building Society sort code in the format 99-99-99, leading zeros 

must be entered e.g. 05-09-98
Building Soc Roll Building society roll number. Use this as well as bank account number 

if payment is to be made to a building society. 
Autopay/Bobs/
TelePay No The 6 digit autopay number if paid by Autopay, the 5 digit Telepay number if 

paid by Telepay or the Bobs number if paid by Bobs.
Bank name Name of bank or building society
Branch name Branch location
Holder Account holder name
The following buttons are shown:
Amend To change the bank details shown
Close To close the window
Close All To close all the windows for this employee
Save To save changes made to the information
Cancel To ignore changes made to the information



Payroll General Details
This window is used to display the general payroll details held for an employee. 
The following information is shown:
Work No Works identification number. Can be left unused.
Department The department the employee works in.
*Tax Code Tax code. Must be a valid format.
*Wk1/Mth1 Mark the check box if tax is deducted on a week 1 or month 1 basis.
*Pay FrequencySelect the pay frequency radio button, either weekly, fortnightly, 4 weekly or

monthly. 
*Pay Method Select the chosen payment method. If Giro Credit or Automated Payment is 

chosen then remember to complete the bank details.
*NI Number Must be 9 characters in the format AA999999A, where A is alphabetic and 9 

is a number. 
*NI Letter Choose the appropriate radio button for the National Insurance letter, one of 

A, B, C, D, E, F, G, X or Z. X indicates the employee is exempted from paying 
National Insurance. Z is used when an employee is given letter C but is 
contracted out in a salary related pension scheme. Do not confuse the last 
character of the NI Number with the NI letter.

Has Company Car Mark the check box only if Class 1A NI is applicable to this employee 
(i.e. has company car and is classified as a director or a higher wage earner),
leave blank if not a company car user.

*Gross Pay The gross pay from any previous employment in this tax year as shown on 
the P45.

*Tax paid The tax paid from any previous employment in this tax year as shown on the
P45.

* indicates the minimum entries needed for a new employee

The following buttons are shown:
Amend To change the bank details shown
Close To close the window
Close All To close all the windows for this employee
Save To save changes made to the information
Cancel To ignore changes made to the information



Current Pay Period
This window is used to display the current pay period details held for an employee. You 
should not need to alter information in this window except for entering the rates and 
amounts for pay additions, and amounts for pay deductions when you first set up the 
employee. Normal changes to pay are entered when using the Pay by commands in the 
Tools menu.
The title bar shows which employee is shown.
The following information is shown down the left hand side:
Tax Code Tax code. 
Tax Week/Mth The tax week or month last paid
Taxable Pay The taxable pay for the period.
Extra Weeks If payment is to cover additional weeks/months, the number of extra weeks 

or months is shown here. If paid fortnightly or 4 weekly then you will see that
1 or 3 extra weeks will be shown.

SSP Any SSP paid in the period.
SMP Any SMP paid in the period.
The central section shows the payments and deductions for this employee. The payments 
(indicated by a +) are shown first depending upon the selections made in the Pay Items 
window. Calculated type additions (i.e. ones that have the Calc column marked in the pay 
additions table) will show three columns, units, rate and amount. Non calculated type 
additions will just show an amount. Deductions are shown (indicated by a -) after the 
additions, excluding tax, NI and pension which are shown on the right hand side.
Finally the current pay period is summarised on the right hand side:
Gross pay Total of all payments.
Deductions Total of all deductions
Rounding Any rounding that has been applied
Net pay The amount the employee will receive
The following buttons are shown:
Amend To change the current period details shown
Close To close the window
Close All To close all the windows for this employee
Save To save changes made to the information
Cancel To ignore changes made to the information
Pay Items Used to amend the additions and deductions used by this employee



Pay Items
This window is used to select the pay additions and deductions to be applied to this 
employee. Pay additions are shown on the left and pay deductions on the right. Deductions 
can optionally have an initial balance specified if they have had the Reduce column marked 
on the employer deductions window.
The check boxes should be marked for those items required. If the deduction is one which 
has a reducing balance, like a loan, then enter the initial balance. You will not be able to 
deselect certain items already marked if they have already been used in a pay calculation 
for the employee. You will have to wait until the start of a new tax year to reuse them. 
The following buttons are shown:
Apply To apply changes made
Cancel To ignore changes made to the information



Year to Date
This window is used to display the year to date details held for an employee. You should not 
normally alter any figures shown here unless setting up your employees part way through 
the tax year. 
The following information is shown down the left hand side:
Tax Code Tax code. 
Tax Week/Month The tax week or month paid to
Taxable Pay The taxable pay year to date.
SSP Any SSP paid year to date.
SMP Any SMP paid year to date.
The central section shows the payments and deductions for this employee. The payments 
(indicated by a +) are shown first. Calculated type additions (i.e. ones that have the Calc 
column marked in the pay additions table) will show two columns, units and amount. Non 
calculated type additions will just show an amount. Deductions are shown (indicated by a -) 
after the additions, excluding tax, NI and pension which are shown on the right hand side.
Finally the year to date details are summarised:
Gross pay Total of all payments.
Deductions Total of all deductions
Rounding If rounding applies two figures are shown. The first is the adjustment amount

for the current tax year and the second is the accumulated value. The 
accumulated value can be positive or negative. If negative the employee is 
owed the amount shown, if positive the employee owes the employer the 
amount shown.

Net pay The net pay year to date.
The following buttons are shown:
Amend To change the year to date details shown
Close To close the window
Close All To close all the windows for this employee
Save To save changes made to the information
Cancel To ignore changes made to the information
Pay Items Used to amend the additions and deductions used by this employee

For a new employee if you have a pay calculation to do before the new employee should be 
paid, then enter the paid to week/month number of the pay run from which you wish to 
exclude him/her.
When transferring existing employees from a manual or other computer system you will 
need to complete the year to date information if it is not the start of the tax year. This will 
ensure that the correct tax and end of year reports can be produced.



National Insurance & Pension
This window is used to display the NI for P60 details and pension details held for an 
employee. 
The following information is shown:
NI Number NI number
Then follows up to 4 columns showing the National Insurance details for the year, each 
column comprising:
SCON No Pension scheme contracted out number (leave blank if not 

applicable). The COMP scheme contracted out number and 
suffix code.

NI Letter National insurance letter
Employee Earnings The year to date NI earnings for the employee when using the 

NI letter shown.
Employee+er Contributions The total of national insurance contributions paid by both 

employee and employer.
Employee Contributions The national insurance paid by the employee only.
C/Out Employee Earnings The year to date contracted out earnings for the NI letter.
C/Out Employee Contribs The contracted out part of the National Insurance paid by the 

employee.
The above details are used to produce P14/60s at the end of the tax year. You should not 
need to alter any of the information unless you are transferring existing employees part way 
through the tax year from another payroll system. When you alter the NI letter in the payroll 
general details, dbsPay2 will automatically put the new letter in the first column and shunt 
the rest along.
At the foot of the NI details are two fields associated with Directors National Insurance. 
These should be used if the person is a director, as directors pay National Insurance on an 
annual basis rather than a pay period basis.
Director Pro Rata Weeks The number of weeks since the beginning of the tax year this 

person will be a director, irrespective of whether they are paid 
monthly or not. This will be 52 if the director was in post at the 
start of the tax year. If they are appointed part way through the 
year, then enter the number of tax weeks remaining in the tax 
year.

Director Gross Pay The year to date gross pay on which the directors NI is 
calculated.

After the directors details, the NIC Holiday details are shown:
NIC Holiday Weeks Paid The number of NIC Holiday weeks recovered to date. This is 

followed by the wording 'NIC Holiday Certificate Held' if the 
employee has an NIC Holiday certificate. If an employee is 
eligible for NIC Holiday then the NI letter P is used in the NI 
Details above. 

Then follows the pension details for this employee:
Employee The fixed amount of employee pension contribution to be deducted each pay



run or the percentage rate to be used.
% Mark the check box if the previous amount is a percentage and not a fixed 

amount.
Paid Period The amount contributed in current pay period by the employee.
Paid Year The amount contributed year to date by the employee.
Employer The fixed amount of employer pension contribution to be deducted each pay 

run or the percentage rate to be used.
% Mark the check box if the previous amount is a percentage and not a fixed 

amount.
Paid Period The amount contributed in current pay period by the employer.
Paid Year The amount contributed year to date by the employer.
Earnings Select the appropriate radio button to determine which earnings are 

applicable for pension calculations.
Pension Type Select the appropriate radio button for COMP, COSR or Other.
Tax allowed Mark this check box if employee COMP rebate amounts are to qualify for tax 

relief, as is normally the case. For COSR or Other pension schemes, if the 
pension scheme does not qualify for tax relief, then this field should be 
blank.

SSP Payments Mark this check box if SSP payments are used in pension calculations.
SMP Payments Mark this check box if SMP payments are used in pension calculations.
The following buttons are shown:
Amend To change the details shown
Close To close the window
Close All To close all the windows for this employee
Save To save changes made to the information
Cancel To ignore changes made to the information



SSP and SMP
This window is used to display the overall SSP and SMP details held for an employee. 
The following information is shown:
Qualifying Days The pattern of days when the employee works. Mark with an X 

those days that are working days for the employee. If you have 
different days in different weeks then this can be changed when
you pay SSP during pay input.

Earnings in previous periods The earnings for SSP/SMP purposes for the last eight pay 
periods.These will be weekly amounts for weekly paid, 
fortnightly amounts for fortnightly paid, 4 weekly amounts for 4 
weekly paid, and monthly amounts for monthly paid. The latest 
pay period is shown first.

Then follows details for both SSP and SMP for the current pay period:
SSP days The number of SSP days taken in the last pay period
SSP amount The amount of SSP paid in the last pay period.
SMP weeks The number of SMP weeks taken in the last pay period.
SMP amount The amount of SMP paid in the last pay period.
NIC compensation on SMP The amount of employer NIC compensation.
Then follows year to date SSP and SMP details:
SSP days The number of SSP days taken in this tax year.
SSP amount The amount of SSP paid in this tax year.
Linked SSP weeks in PIW The number of linked SSP days taken expressed in terms of 

weeks to three decimal places. This is used to determine when 
SSP payments should cease.

SMP weeks The number of SMP weeks taken in this tax year.
SMP amount The amount of SMP paid in this tax year.
NIC compensation on SMP The amount of employer NIC compensation.
Then follows previous employment SSP details as taken from the SSP1(L) leavers form when 

the
employee joined you:
SSP Start Date The start date of the last SSP with the previous employer.
SSP End Date The end date of the last SSP with the previous employer.
SSP Weeks The number of SSP weeks between start and end dates.
You should not need to alter any of the information unless you are transferring existing 
employees part way through the tax year from another payroll system.    dbsPay2 will 
automatically maintain the information for you once the qualifying pattern of days is 
entered. The above is the minimum amount of information required for SSP and SMP 
calculation purposes. Other information is required by law for SSP and SMP purposes and 
dbsPay2 can record these details if you use the SSP and SMP buttons during Pay Input. This 
other information can be viewed by using the View SSP and View SMP commands in the 
Tools menu. 



The following buttons are shown:
Amend To change the details shown
Close To close the window
Close All To close all the windows for this employee
Save To save changes made to the information
Cancel To ignore changes made to the information



Paying Employees Overview
Paying your employees is achieved by using the following commands in the Tools menu:
Pay All Inputs pay details and calculates the pay for all employees.
Pay Department Inputs pay details and calculates pay in department sequence 

for a selected department.
Pay Employee Inputs pay details and calculates pay for an individual.
You can repeat a pay calculation as many times as you like until you close the pay period. 
Closing the pay period will update the year to date information, Inland Revenue returns and 
generate postings to GL. You must close the pay period before you pay the next one.
If you have any Class 1A NI payments to be made these should be done using the Class 1A 
NIC command in the Tools menu before the normal pay input process for the period.
If you have any NI refunds or additional NI payments to be made, then use the Amend NI 
command in the Tools menu before the normal pay input process for the period.
Related Topics:

To pay an individual employee
To pay all employees that belong to a department
To pay all employees



To pay an individual employee
1. Choose the Pay Employee command in the Tools menu.
2. Select the employee to be paid.



To pay all employees that belong to a department
1. Choose the Pay Department command in the Tools menu.
2. Select the department required and the sequence employees will be shown in.
3. If you wish to choose individual employees to be paid, mark the Choose the ones to 

be paid? check box. 



To pay all employees 
1. Choose the Pay All command in the Tools menu.
2. Choose the sequence you wish employees to be shown to you. 
3. If you wish to choose individual employees to be paid, mark the Choose the ones to 

be paid? check box.



Pay Period 
The pay period window allows you to choose the pay period to be paid. You can also just 
enter the pay changes without calculating the pay and use the Calculate Pay option later or 
for each employee enter their pay details and calculate the results.
The following information is shown:
Pay Period Enter the tax week or month to be paid if this is the first time of use for the 

pay frequency chosen. It should default correctly for future pay runs when 
you select the pay frequency button.

Pay Frequency Select the employees to be included by choosing one of the radio buttons:    
Weekly, 2 Weekly, 4 Weekly or Monthly.

Payment Method Select the appropriate radio button, use Both if you want to input 
details and calculate the pay displaying the results; use Input Details to just 
enter the pay information without calculating the pay; and use Calculate Pay 
to calculate the pay after you have previously entered details, no display of 
the results are shown in this case.

Zero items Unmark this check box if you do not want dbsPay2 to zeroise any additions 
and deductions that have their Zero Column checked in the Employer 
Additions and Deductions. Typically, this will be necessary if you are using 
the dbsPay2 Import optional application.

The following buttons are available:
Proceed Proceed to display pay input details
Cancel Abort the pay run and close the window
When you have entered details about the pay run to be performed then click the Proceed 
button to show the first employee to be paid. Click the Cancel button only if you wish to 
abandon the pay run without paying anyone. If you chose to Choose the employees to be 
paid then the Select Employees window is shown to allow you to mark those required by 
entering a Y in the Paythis column. Use the up and down arrow keys to move up and down 
this list to mark your selections. having marked those required, double click the close button
(top left hand corner) of the Select Employees window.



Employee Pay 
The employee pay window is used to specify changes to the payments and deductions to be 
made from this employee.
The information shown will depend on which pay addition and deduction names have been 
allocated to the employee.
Extra weeks should only be used if additional weeks are required. Do not use to signify 
fortnightly or 4 weekly paid as this will be done automatically for you when paying 
employees for those particular pay frequencies.
The following buttons are shown:
Calculate Click this when you want to calculate the resultant pay for this employee and

see the resultant payslip window.
Ignore Click this to ignore this employee and show the next. 
Abort Click this if you wish to abort the pay run at this point
Holidays Click this if you wish to enter holiday details. This is only a recording of 

holiday dates taken not holiday pay. You must still enter your holiday pay 
under an appropriate pay addition field that you have set up for this purpose.

SSP Click this if you wish to enter SSP details
SMP Click this if you wish to enter SMP details
Related Topics:

To pay this employee



To pay this employee
1. If the employee is involved in a trade dispute click the Trade Dispute check box. Enter

any SSP to be paid by clicking on the SSP button, the SSP Input window is shown.
2. Enter any SMP to be paid by clicking on the SMP button, the SMP Input window is 

shown.
3. Enter any holiday recording by clicking on the Holidays button.
4. Enter any other changes. If the pay period involves extra weeks for instance if paying

holiday pay then enter the number of additional weeks in the extra weeks field.
5. Click the Calculate button.
6. The Payslip Window is shown to allow you to review the calculations. 
7. If you are ready to save the calculations click the Save button, if you wish to ignore 

the calculations for this employee and go on to the next employee click the Ignore 
button, and if you wish to redo the calculation for this employee then click the Redo 
button.



Holiday Recording
The Holiday Input window is shown if the Holidays button is used during pay input. You can 
also record holidays outside of a pay run by choosing the View Holidays command from 
the Tools menu.This shows you all holiday dates held for the employee. If you wish to use 
the holiday recording facility you should set the holiday entitlement for each employee on 
the Personnel Details window.
The following information is shown if you use the command from the Tools menu:
Start Date Start date of a holiday 
End Date End date of the holiday
Related Topics:

To add new holiday dates



To add new holiday dates
1. Click the right mouse button.
2. Click the New button.    
3. Enter the holiday dates.
4. Click the Save button to keep the dates, Cancel to cancel.



Holiday Input
The Employee Holiday window is used to record holiday dates.
The following information is shown:
Start Date The start date of the holiday period
End Date The end date of the holiday period
Days The number of actual days in the period used for holidays. You will need to 

ignore public holidays, non working days etc. The days are entered to two 
decimal places to allow for parts of a day.

Entitlement The number of days allowed for this employee
Taken The number of days already taken
Left The number of days left to take.
The following buttons are available:
New To add a new holiday
Amend To alter the details shown
Delete To delete the holiday shown
Close To close the window
Reset All To reset all holiday records for the start of a new holiday year. This will set 

the days taken to zero and the days left to the current entitlement and 
delete all holiday dates recorded for the group of employees being viewed, 
depending on whether you selected all, a particular department or an 
individual employee.

Save To save any changes made
Cancel To ignore any changes made.



SSP Input
The SSP Input window is shown to record details of the SSP to be paid. This is shown if the 
SSP button is used during pay input.
You enter the start date and end date and the window displays an appropriate pattern of 
days. A maximum of one month can be entered.
The following information is shown:
Start Date Start date of sickness
End Date End date of sickness
Days The total number of days between the start and end dates.
Then follows a calculated pattern based on the dates entered and previous sickness that has
been recorded.
Date The date of the start of the week.
Qualifying daysThe number of qualifying days in the week.
Sun..Sat The Sunday to Saturday boxes will contain a W if the day is a waiting day, S 

if the day is a paid sick day, Q if the day is a qualifying day, space/blank if 
the day is a non qualifying day and X if a disputed day. 

Linked PIW Mark the check box if this sickness is part of a previous PIW. In this case the 
previous SSP rate payable will be used. If this is a new PIW leave the check 
box blank.

Waiting Days The calculated number of waiting days.
SSP Days The calculated number of sick days.
Non SSP Days The calculated number of non SSP days.
Disputed Days The calculated number of disputed days.
Reason If you decide not to pay SSP then you should enter Xs in the days disputed 

and enter the reason for non payment here.
Average Earnings The earnings upon which the SSP rate was calculated. 
Weekly Rate The weekly rate of SSP paid.
Amount The total amount of SSP paid.
The following buttons are available:
Calculate Used to calculate the waiting days, number of days to be paid, rate of SSP to 

be paid and the amount if you make changes to the pattern.
Close Closes the window ignoring changes made.
Include Used to save changes made and include the amount calculated in the 

Employee Pay window.
Exclude Used to ignore changes made and reset the SSP amount to zero in the 

Employee Pay window. 
Related Topics:

To pay SSP



To pay SSP
1. Enter the start and end dates for this period of sickness absence.
2. dbsPay2 will calculate the SSP and the pattern of days based on any previous 

sickness and the qualifying days pattern. 
3. Check the days paid, waiting days and non working days are correct. Waiting days 

will normally be 3 unless the illness is linked in which case it will usually be 0. 
4. If you want to change the calculated pattern then enter your changes and click the 

Calculate button. If you are disputing payment enter your reason for non payment 
and mark the disputed days with an X.

5. If the average earnings figure is below the SSP Earnings limit no SSP is payable, but if
this is the first time you are paying the employee the average earnings figure will 
need entering and then the Calculate button clicked. 

6. To save the calculated figure click the Include button. To ignore the calculations and 
set the SSP paid to zero, click the Exclude button. To ignore the changes and leave 
the SSP Paid as before then click the Close button.



SMP Input
The Employee SMP window is shown if the SMP button is used in pay input for the first time.
The employee must have already had an SMP record initialised by using the Initiate SMP 
command in the Tools menu otherwise the SMP button will not be selectable. As soon as 
you are given notice of maternity absence you should initiate the SMP record.
This window shows the information previously entered when the SMP was initiated and 
allows you to amend the average earnings figure if required.
The following information is shown:
Date Informed Date when SMP record was set up.
EWC Expected week of confinement date, the Sunday of the week in 

which the expected date falls.
Expected Start Date The date from which SMP payments are to be made, usually 11 

weeks before EWC.
Qualifying Week Date The qualifying week date is 15 weeks before the EWC.
Actual Week of Confinement The Sunday of the actual week the baby was born.
Actual Start Date The actual date payments were made from.
Excluded from SMP This check box is marked if the employee is excluded from SMP.
Excluded from Date The date the exclusion is from
Given Exclusion Form This check box is marked if the employee has been given an 

exclusion form, SMP1.
Average Weekly Earnings The average weekly earnings for the last 8 weeks up to the last 

pay day before the end of the qualifying week. This is calculated
by dbsPay2 if you have used dbsPay2 for the period concerned, 
but you may wish to override the earnings if payments have not
been put through dbsPay2.

Last Pay Day The date of the last pay day.
Higher Rate The higher rate of SMP that will be used for the first 6 SMP pay 

weeks. Calculated as a percentage of the average earnings.
Lower Rate The lower rate of SMP that will be used for all other SMP 

payments after the first six.
The following buttons are shown:
MPP Used to create the MPP record and enter payments on the Maternity Pay 

Period window.
Close To close the window
You should not use the MPP button until you are ready to start making the actual payments 
as the actual start date will be set when you use the Maternity Pay Period window.



MPP 
The Employee MPP window shows the maternity pay periods and allows you to specify those 
to be paid in this pay input.
The dates and periods are automatically set for you once you use the MPP button for the first
time.
The following information is shown, one row for each of the maximum 18 weeks in which 
SMP is payable:
MPP Week The date of the maternity pay period week.
Tax Week The associated tax week.
Work/Pay/Exclude Choose the appropriate radio button to indicate whether they 

worked, should be paid SMP or excluded for the week.
Amount Calculated when select the Pay radio button.
Total Calculated as you pay SMP.
Notes Use to give reasons for exclusion etc.
The following buttons are available:
Save To save any changes made
Cancel To ignore any changes made.



Payslip Window
The Employee Payslip window shows the results of calculating the pay for an individual 
employee.
The contents of the window will vary depending on the pay additions and deductions 
allocated to the employee.
The following buttons are shown:
Save Save the calculations and get the next employee.
Redo Return to the pay input window to allow the calculation to be redone.
Ignore Ignore the calculations for this employee and go on to the next employee.
Abort Abort the pay input process.



Close Pay Period
The pay calculations for a period are used to update the year to date information held, the 
Inland Revenue returns and the GL posting when the Close Pay Period command is used in
the Tools menu.
You must close the pay period once you are satisfied that all employees have been paid 
correctly. You will not be able to pay the next period until the current pay period has been 
closed.
The following information is shown:
Pay Period The pay period to be closed.
Pay Frequency The employees who match the pay frequency chosen will be actioned.
The following buttons are available:
Proceed Close the pay period.
Cancel Don't close the pay period.



Post to GL
The Post to GL command in the Tools menu allows you to generate either a printed report 
or a tab delimited file for use with your General Ledger accounting software. This can be 
chosen at the appropriate point and not necessarily after each pay run. For example, you 
would probably post the entries to your GL when you wish to do your accounting.
The file generated is able to be imported directly into MYOB Accounting using the Import 
Data command of MYOB. 
The following information is shown:
ASCII File/Report Select the appropriate radio button.
Filename If using ASCII, enter the name of the file e.g. GLPAY.PST.
Posting Date The date to be printed on the report or used as the posting date

in the file.
Journal Number Up to 8 characters, to identify this particular posting.
The following buttons are available:
Proceed Generate the posting report or file. 
Cancel Don't generate postings.



Reporting Overview
The reporting is controlled by the print commands in the Reports menu.
Print Prints the reports to a printer or disk file
View Views previous reports stored on disk
The printer used is determined from the printer currently set up as the default to work with 
Microsoft Windows when running under Windows, and by the Chooser settings in your 
Macintosh Control Panel. Special stationery reports are designed for use with tractor feed 
printers and will prompt you to choose the printer from those configured with your operating
system.
Certain reports require the period to have been closed before you print them, these are 
denoted with an asterisk in the Print window.
Most reports have a summary at the end of the report showing which pay periods have been
calculated and which closed if the report is dependant upon the pay period status.



General Reporting Information
Reports required by the Inland Revenue & DSS
Completing PAYE Statutory Forms



Reports required by the Inland Revenue & DSS
Every time you pay your employees you must keep a record of the following:

All payments that count for tax purposes
The tax deducted or refunded to an employee
The total of the employer's and employee's NI 
contributions
The employee's NI contributions.
The employee's NI contributions at the contracted out 
rate, if applicable
The amount of SSP payments made to employees
The amount of SMP payments made to employees
Earnings on which employee's contributions are payable
at standard rates
Earnings on which employee's contracted out 
contributions are payable at standard rates

This is one of the reasons why the P11 Substitute report is required, as this report provides 
all the above information. It is therefore essential that you print this report for each pay 
period and keep it for at least three years after the end of the tax year they cover.
The following reports list the most commonly required ones:
Payslips Produce each pay period
Detailed Payment Summary Produce each pay period
Overall Payment Summary Produce each pay period
P11 Produce each pay period
P14/60 Produce after the last pay period of the tax year
P35 Produce after the last pay period of the tax year
P45 Produce when an employee leaves your employment
Inland Revenue Returns Produce so that the Payslip Booklet can be completed.



Completing PAYE Statutory Forms
Payslip Booklet P30BC(Z)
P45
P14/P60
P35
P11
P11(D)



Payslip Booklet P30BC(Z)
You display or print the Inland Revenue Returns report, and manually complete the 
information. Alternatively the information can be found in the Overall Payment Summary 
reports for the pay periods in question but you will need to add the figures from several 
reports. This can be useful for cross checking that the information held in the Inland 
Revenue Returns has not been manually adjusted or set up incorrectly



P45
When an employee leaves your employment, or dies, you will need to complete a P45 
document supplied by the DSS. dbsPay2 helps you manually to complete this document by 
the information shown on the P45 report. To print the P45 report you must have already 
completed the last pay run for the employee and also entered a date of leaving in the 
personnel details. 
You should transcribe the information shown on the P45 report onto the DSS P45 3 part 
document. You will need to send one part of the document to your tax office immediately, 
and give your employee parts 2 and 3 which should remain unseparated.
If the employee has died, then remember to enter a D in the box near the bottom of the P45
document and send the entire P45, unseparated, to your tax office immediately.



P14/P60
This report should only be produced at the end of the tax year and it is important that you 
print the reports and submit them before the due date. New OCR style reports were 
introduced for the tax year ending April 1998, which contain special drop out inks, hence 
dbsPay2 can no longer just print the forms onto plain A4 paper. The following forms are 
supported in the Windows version: Inland Revenue supplied P14(OCR) (Laser-Sheet) suitable 
for A4 laser and ink-jet printers and dbs supplied P14/60 (Substitute) (P) (12" deep x 9" 
wide) manufactured by Custom Forms Ltd suitable for most impact printers.
For Macintosh users only, the dbs supplied P14/60 (Substitute) (P) (12" deep x 9" wide) 
manufactured by Custom Forms Ltd is supported for use with Imagewriter and AT Epson FX 
impact printers. If you do not have an impact printer, then dbs can offer a printing service or
a combined end of year returns on disk and printing service from data supplied by you.



P35
A P35 form is a summary of the Employer's Annual Statement Declaration and Certificate. 
This form, like the P14/60's, must be completed by the due date to avoid being penalised. 
dbsPay2 provides the second part of this form, the P35(cs). The P35(cs) report should be 
printed and attached to the DSS supplied P35 front sheet.



P11
The P11 form issued by the DSS is never completed as the dbsPay2 P11 substitute report will
provide the details required for statutory purposes.



P11(D)
Returns on P11(D) forms, for expenses for higher paid staff,    must be made manually. 
dbsPay2 does not print these forms, but the information shown on the payslips and payment
summaries will help in completing the forms for those individuals a return has to be made 
for. 



End of Year Reporting
At the end of the tax year, employers are required to return a statement of the pay, tax and 
National Insurance contributions, Statutory Sick Pay and Statutory Maternity payments. The 
most commonly required forms are listed below, however the year-end instructions received 
from the Inland Revenue/DSS will be more explicit as to which forms will be required for your
company.
P9D Manually completed from dbsPay2 information
P11D Manually completed from dbsPay2 information
P14/60 Printed by dbsPay2
P35 Manually completed then attach P35cs
P35cs Printed by dbsPay2
We suggest that you print and file the following reports after completing your last pay run 
for the tax year:
P14/60
P35(cs)
Employee details
P11
Overall payment summary YTD
Detailed payment summary YTD

You are required to retain the reports for a minimum specified period as determined by the 
Inland Revenue and DSS, currently three years.

If you have more than 100 employees you are eligible to send your P14 returns on magnetic 
disk. Deverill Business Systems can supply you with an optional add on to dbsPay2 to allow 
you to generate the end of year returns on disk and print the single P60 for giving to your 
employees, contact dbs for further information. 



Report Settings
When printing your reports, you will be shown the Report Settings window to ensure that the
correct settings are shown for the reports you wish to print.
The following information is shown:
Report date The date to be printed on the report
Pay Frequency Mark the check boxes for the employee pay frequencies required
Scope Choose the radio button for the selected category of employees to be 

reported: All, Selected Department, Selected Individual.
Selection If selected department is chosen, then the actual department required is 

chosen here
If selected individual is chosen, then the actual individual required is chosen 
here

Destination Choose either Printer or Disk radio buttons.
Filename If printing to disk, then enter the filename you want the report to be saved 

as.
View Report If printing to disk, marking this check box allows you to view the report once 

it has been generated.
The following buttons are shown:
Proceed To use any changed report requirements
Cancel To ignore any changes made and cancel the report printing



Choosing your report
When you choose the Print command in the Reports menu the Print Reports window allows
you to choose which reports you wish to display or print.
You should mark the check boxes of those reports you wish to print. If printing to disk then 
only one report can be printed at a time.
The security payslips, giro credits, and Portrait P14/60 Continuous special stationery reports 
are designed for use with impact (dot matrix) printers only. You will need to set the user 
defined report page size correctly when using Windows for each report:
Security payslip (available from dbs) In .01 in 800 (width) x 500 (depth)
Giro Credit (available from dbs) 800 x 350
Portrait P14/60 (available from dbs) 800 x 1200
The label stationery is designed for A4 sheets of Avery L7163, giving 14 labels per sheet.
All other reports are designed for A4 stationery, and are printed in portrait mode except for 
the Government supplied P14/60 which is printed in landscape mode.
The following buttons are shown:
Print To print the reports chosen
Remember To remember your current selections for the next time you invoke the 

command
Cancel To cancel without printing
Recommended To select the dbs recommended reports
Clear To remove all selections shown
Related Topics:

To print reports



To print reports
1. Select the reports you require by marking the appropriate check boxes
2. Click the Print button
3. If more than one report is selected they will be printed to the default printer. If a 

single report is selected it will be printed to either a printer (any of the printers 
configured) or a disk file depending on the report settings. 



Viewing reports on disk
Choose the View    command from the Reports menu to see a list of reports that you have 
previously generated.
Related Topics:

To display a report
To print a report
To delete a report
To close the window



To display a report
1. Select the report desired from the list shown.
2. Click the View button.



To print a report
1. Select the report desired from the list shown.
2. Click the Print button.



To delete a report
1. Select the report desired from the list shown.
2. Click the Delete button.



To close the window
1. Click the Close button.



Tools Menu 
The Tools menu contains several commands that are used infrequently. 
The following commands in the Tools menu are described:
View Holidays View details of employee holidays
View SSP View details of SSP absence 
View SMP View details of SMP absence
Initiate SMP Initiate an SMP record when notified
Amend Tax Codes Bulk tax code changes for all employees.
Class 1A NIC Input of Class 1A NIC details for employees with company cars.
Amend NI Refund or deduct additional National Insurance.
NIC Holiday Initiate NIC Holiday recovery for an eligible employee.
End of Year End of year processing for all employees.
Pay Review Allows percentage increases to be applied to employees pay 

additions. 
Automatic IDs Allows generation of IDs for employer, employee and 

department to be automatic or manually entered.
Security Levels Allows security levels for menu commands to be altered.



View Holidays
The View Holidays command in the Tools menu allows you to record holidays taken by 
employees against days allowed. This facility is also available whilst paying employees. It 
only records holidays taken against holidays allowed, if you also pay holiday pay separately 
from normal wages, then you will need to complete that during the pay input process.
The following information is shown:
Scope Choose the radio button for the selected category of employees to be 

displayed: All , Selected Department, Selected Individual.
Selection If selected department is chosen, then the actual department required is 

chosen here
If selected individual is chosen, then the actual individual required is chosen 
here

The following buttons are shown:
Proceed To commence the holiday recording for the selected employees
Cancel To cancel the holiday recording and close the window 
Related Topics:

To record holiday for selected employees



To record holiday for selected employees
1. Select the employees the holiday process is to be carried out for.
2. Click the Proceed button to start the process, or click the Cancel button to abort.
3. The Employee Holidays list window is shown to display previously recorded holiday 

details.
4. Click the right mouse button when positioned on the employee you wish to record the

holiday for.
5. The Employee Holiday window is shown to allow you to add the holiday details.



Employee Holidays List
This shows you all holiday dates held for the selected employees. If you wish to use the 
holiday recording facility you should set the holiday entitlement for each employee on the 
Personnel Details window.
The following information is shown:
Department Not shown if scope is a selected department or employee
Title Not shown if scope is a selected employee
Forenames Not shown if scope is a selected employee
Surname Not shown if scope is a selected employee
Start Date Start date of a holiday 
End Date End date of the holiday
Related Topics:

To add new holiday dates



To add new holiday dates
1. Click the right mouse button.
2. Click the New button.    
3. Enter the holiday dates.
4. Click the Save button to keep the dates, Cancel to cancel.



Holiday Input
The Holiday Input window is shown for each selected employee to enable holiday details to 
be recorded. You can just record the number of days taken or you can specify the dates as 
well.
The following information is shown:
Start Date The start date of the holiday period
End Date The end date of the holiday period
Days The number of actual days in the period used for holidays. You will need to 

ignore public holidays, non working days etc. The days are entered to two 
decimal places to allow for parts of a day.

Entitlement The number of days allowed for this employee
Taken The number of days already taken
Left The number of days left to take.
The following buttons are available:
New To add a new holiday
Amend To alter the details shown
Delete To delete the holiday shown
Close To close the window
Reset All To clear the holiday details for the start of a new holiday year. Ensure that 

the holiday reports you wish to keep have been printed as this process will 
delete the existing dates held.

Save To save any changes made
Cancel To ignore any changes made.



View SSP
The View SSP command in the Tools menu allows you to view detailed SSP information.
The following information is shown:
Scope Choose the radio button for the selected category of employees to be 

viewed: All , Selected Department, Selected Individual.
Selection If selected department is chosen, then the actual department required is 

entered here
If selected individual is chosen, then the actual individual required is entered
here

The following buttons are shown:
Proceed To commence the SSP display for the selected employees
Cancel To cancel the SSP display and close the window 
Related Topics:

To view SSP details for selected employees



To view SSP details for selected employees
1. Select the employees the SSP process is to be carried out for.
2. Click the Proceed button to start the process, or click the Cancel button to abort.
3. The Employee SSP list window is shown to view the SSP details.



Employee SSP List
This shows you all SSP dates held for the selected employees. The following information is 
shown:
Department Not shown if scope is selected department or selected employee
Title Not shown if scope is selected employee
Forenames Not shown if scope is selected employee
Surname Not shown if scope is selected employee
Start Date Start date of sickness
End Date End date of the sickness
Related Topics:

To view SSP Details



To view SSP Details
1. Position on the SSP entry shown in the list to be viewed.
2. Click the right mouse button.
3. The SSP Details window is shown. 



SSP Details
The SSP Details window is shown to view or delete details of previous SSP payments. SSP 
details are added only during the pay input process.
The following information is shown:
Start date Start date of sickness
End date End date of sickness
Days Number of days between start and end dates.
Waiting Days Number of waiting days between the start and end dates.
SSP Days Number of SSP days paid
Non SSP days Number of non working days between the start and end dates.
Disputed Days Number of disputed days between the start and end dates.
Reason for Non Payment Description of why payment was refused.
Amount SSP amount paid
The following buttons are available:
Amend Amend the reason for non payment field only.
Delete Delete the SSP detail
Close Close the window
Save Save any changes made
Cancel Ignore any changes made.



View SMP 
The View SMP command in the Tools menu allows you to view statutory information about 
maternity leave.
The following information is shown:
Scope Choose the radio button for the selected category of employees to be 

viewed: All , Selected Department, Selected Individual.
Selection If selected department is chosen, then the actual department required is 

entered here
If selected individual is chosen, then the actual individual required is entered
here

The following buttons are shown:
Proceed To commence the SMP display for the selected employees
Cancel To cancel the SMP display and close the window 
Related Topics:

To view SMP details for selected employees



To view SMP details for selected employees
1. Select the employees the SMP process is to be carried out for.
2. Click the Proceed button to start the process, or click the Cancel button to abort.
3. The Employee SMP list window is shown to view the SMP details.



Employee SMP List
This shows you all SMP absences held for the selected employees. 
The following information is shown:
Department Not shown if scope is selected department or selected employee
Title Not shown if scope is selected employee
Forenames Not shown if scope is selected employee
Surname Not shown if scope is selected employee
Expected Start Date
Expected Week of Confinement
Related Topics:

To view SMP Details



To view SMP Details
1. Position on the SMP entry shown in the list to be viewed.
2. Click the right mouse button.
3. The SMP Details window is shown.



SMP Details
The SMP Details window is shown to view details of previous SMP payments.
The following information is shown:
Date Informed Date when SMP record was set up.
EWC Expected week of confinement date, the Sunday of the week in 

which the expected date falls.
Expected Start Date The date from which SMP payments are to be made, usually 11 

weeks before EWC.
Qualifying Week Date The qualifying week date is 15 weeks before the EWC.
Actual Week of Confinement The Sunday of the actual week the baby was born.
Actual Start Date The actual date payments were made from.
Excluded from SMP This check box is marked if the employee is excluded from SMP.
Excluded from Date The date the exclusion is from
Given Exclusion Form This check box is marked if the employee has been given an 

exclusion form, SMP1.
The following buttons are available:
Amend Amend the actual dates shown.
Delete Delete the SMP Details
Close Close the window
Save Save any changes made
Cancel Ignore any changes made.
MPP View the detailed Maternity Pay Period record



MPP 
The Employee MPP window shows the maternity pay periods.
The MPP details are normally created and amended during pay input. The Amend facility 
available here is to allow entry of information if dbsPay2 is used part way through a 
maternity absence when transferring data from another payroll system.
The following information is shown, one row for each of the maximum 18 weeks in which 
SMP is payable:
MPP Week The date of the maternity pay period week.
Tax Week The tax week it applies to.
Work/Pay/Exclude Indicates whether they worked,    paid SMP or excluded for the 

week.
Amount SMP paid for week
Total Total SMP paid during this absence
Notes Use to give reasons for exclusion etc.
The following buttons are available:
Amend To amend details 
Close To close the window
Save To save any changes made
Cancel To ignore any changes made.



Initiate SMP
The Initiate SMP command in the Tools menu is used to set up the initial details about a 
forthcoming Statutory Maternity Pay absence. You should use this command when the 
employee notifies you of their maternity absence and provides medical evidence of her 
expected week of confinement. You must check that she complies with all the rules to be 
eligible for statutory maternity pay.
The following information is shown:
Employee Select the employee who has notified you of her intended maternity 

absence.
The following buttons are shown:
Proceed To commence the SMP for the selected employee
Cancel To cancel the SMP initialisation and close the window 
Related Topics:

To set up SMP details for an employee



To set up SMP details for an employee
1. Select the employee from the list box.
2. Click the Proceed button to display the Initiate SMP details or click Cancel to close 

the window.



Initiate SMP Details
The Initiate SMP Details window is shown to set up the SMP recording for a forthcoming 
maternity absence.
The following information is shown:
Date Informed Date when SMP record was set up.
EWC Expected week of confinement date, the Sunday of the week in 

which the expected date falls.
Expected Start Date The date from which SMP payments are to be made, usually 11 

weeks before EWC.
Qualifying Week Date The qualifying week date is 15 weeks before the EWC.
Actual Week of Confinement The Sunday of the actual week the baby was born.
Actual Start Date The actual date payments were made from.
Excluded from SMP This check box is marked if the employee is excluded from SMP.
Excluded from Date The date the exclusion is from
Given Exclusion Form This check box is marked if the employee has been given an 

exclusion form, SMP1.
The following buttons are available:
Initiate Generate an SMP record 
Cancel Ignore any changes made.



End of Year 
The End of Year command in the Tools menu allows you to get the employee data ready 
for the start of a new tax year, by clearing all the year to date information. You should 
ensure that you have taken a backup of your data before you use this command. Employee's
who have left may be deleted provided they are not liable for Class 1A National Insurance 
(i.e. company car users) as the class 1A    entry will probably be made in the next tax year.
The following information is shown:
Remove employees 
who have left Mark the check box if employees who have left are to be 

permanently deleted.
The following buttons are shown:
Proceed To commence the end of year reset for all employees
Cancel To cancel the end of year reset and close the window 
Related Topics:

To reset employees for the start of a new tax year



To reset employees for the start of a new tax year
1. Decide whether leavers are to be deleted. If you have yet to pay Class 1A NIC to any 

employees who have left they will not be removed until the end of the following tax 
year.

2. Click the Proceed button.



Amend Tax Codes
If you receive a P7X or P9X form from the Inland Revenue advising you to change tax codes 
for all employees who have cumulative suffix codes then the Amend Tax Code command in
the Tools menu will allow you to easily update all the employees concerned.
The following information is shown:
L Enter changes to tax codes with suffix letter L. Precede with a minus sign if 

reducing the tax code e.g. -20
H Enter changes to tax codes with suffix letter H. Precede with a minus sign if 

reducing the tax code e.g. -20
P Enter changes to tax codes with suffix letter P. Precede with a minus sign if 

reducing the tax code e.g. -20
T Enter changes to tax codes with suffix letter T. Precede with a minus sign if 

reducing the tax code e.g. -20
V Enter changes to tax codes with suffix letter V. Precede with a minus sign if 

reducing the tax code e.g. -20
All Employers Mark this check box if you wish to apply this change to all employers if you 

are running several employers in a bureau situation.
The following buttons are shown:
Apply To apply the changes to the tax codes
Cancel To cancel the tax code change and close the window 
Related Topics:

To increase/decrease tax codes



To increase/decrease tax codes
1. Enter the change to the tax codes for the tax letters shown.
2. Click the Apply button to change all employees by the values you entered. If you 

want to abandon changing the tax codes click the Cancel button.



Company Car National Insurance
The Class 1A NIC command in the Tools menu allows you to enter Class 1A National 
Insurance for company car users.
The following information is shown:
Scope Choose the radio button for the selected category of employees to be 

viewed: All , Selected Department, Selected Individual.
Selection If selected department is chosen, then the actual department required is 

entered here
If selected individual is chosen, then the actual individual required is entered
here

% Scale ChargeThe percentage scale charge to be applied
The following buttons are shown:
Proceed To commence the Class 1A NIC input for the selected employees
Cancel To cancel the Class 1A NIC input and close the window 
Related Topics:

To enter the Class 1A car amounts



To enter the Class 1A car amounts
1. Select the employees to apply the calculation to.
2. Enter the percentage scale charge rate.
3. Click the Proceed button.
4. The Class 1A NIC window is shown.



Class 1A NIC 
This window is shown for an employee who is marked as liable for Class 1A NIC and has 
been selected for the entry of the amounts.
The following information is shown:
Car The amount applicable for the car from tables supplied by DSS.
Fuel The amount applicable from tables supplied by DSS.
% Scale ChargeThis is shown for information only, it is the % rate defined when selecting 

employees.
NI Employer The calculated NI employer amount for Class 1A.
The following buttons are shown:
Save Save the calculations and get the next employee
Ignore Ignore the calculations for this employee and go on to the next employee
Abort Abort this employee and any further employee calculations
Related Topics:

To enter scale amounts and calculate NI payable



To enter scale amounts and calculate NI payable
1. Enter the car and/or fuel amounts from the tables supplied by DSS applicable to the 

car and mileage for this employee.
2. Ensure that the % scale charge figure shown is correct. If not then click the Abort 

button, and respecify the % on the Select Employees window that is shown when 
choosing the Class 1A NIC command in the Tools menu.

3. Click the Save button to keep the calculations for this employee or the Ignore 
button to ignore calculations for this employee and get the next employee.



Amend NI
The Amend NI command in the Tools menu allows you to enter additional National 
Insurance to be deducted or refunded for a single employee when you are informed by DSS 
that you should make this additional NI deduction or refund.
The following information is shown:
Employee ID The actual individual required is entered here
The following buttons are shown:
Proceed To enter the NI amendment for the selected employee
Cancel To cancel the amendment and close the window 
Related Topics:

To enter the NI Refund or Payment



To enter the NI Refund or Payment
1. Select the employee.
2. Click the Proceed button.
3. The NI Amendment window is shown.



NI Amendment 
This window is shown for the selected employee.
The following information is shown:
Employee NI
    Refund The amount of NI to be refunded to the employee
    Payment The amount of NI to be paid by the employee
Employer NI
    Refund The amount of NI to be refunded to the employer
    Payment The amount of NI to be paid by the employer
The following buttons are shown:
Save Save the changes
Cancel Ignore any changes and close the window



NIC Holiday
The NIC Holiday command in the Tools menu allows you to initiate the recovery of 
employer NIC contributions for employees who qualify and hold an NIC Holiday certificate. 
Only employees whose start date is on or after 6th April 1996 will be shown for selection.
The following information is shown:
Employee ID The actual individual required is selected here
The following buttons are shown:
Proceed To enter the NIC Holiday details for the selected employee
Cancel To cancel the amendment and close the window 
Related Topics:

To initiate the NIC Holiday



To initiate the NIC Holiday
1. Select the employee.
2. Click the Proceed button.
3. The NIC Holiday Certificate window is shown.



NIC Holiday Certificate
This window is shown for the selected employee.
The following information is shown:

    No of NIC Hol Weeks Paid The no of weeks already paid since the employee started 
working for you, i.e. the number of closed pay weeks. Ensure 
that the calculated number of weeks is correct as NIC Holiday 
will automatically cease once 52 weeks are recovered.

    Amount to be reclaimed The amount of employer NI that will be reclaimed when you 
click the reclaim button. This is automatically calculated for you 
from the NI employer contributions paid to date and it also 
reclaims the extra amount if the employee is contracted out, as 
you are allowed to reclaim the contracted-in rate. You should 
not need to change this calculated value.

The following buttons are shown:
Reclaim To initiate NIC Holiday for this employee. The NI for P60 details will now show

the NIC Holiday and use NI Letter P to show amounts reclaimed. The Inland 
Revenue Returns will be adjusted to show the amount reclaimed ready for 
your next submission.

Cancel Ignore any changes and close the window



Pay Review
The Pay Review command in the Tools menu allows you to adjust payments by set 
amounts or percentages either globally without viewing changes made or an individual at a 
time basis. You may wish to take a backup before you do the pay review.
The Pay Review window is shown to allow you to specify the changes to the pay additions 
and deductions that are to be applied to employees.
The following information is shown:
Additions Pay addition name
Calc Shown for information only so you are aware that the amounts will be rates
Change The fixed annual amount to alter the pay addition by or the percentage rate 

to be applied. If the field is a calculated one (denoted by the Calc check box) 
and you want an amount then the amount will be the change required, e.g. If
overtime was 5.05 and wanted to change the overtime to 5.30, enter 0.25. 

% Mark the check box if the previous column was a rate, leave blank if it was 
an amount.

Deductions Pay deduction name
Change The fixed annual amount to alter the pay deduction by or the percentage 

rate to be applied
% Mark the check box if the previous column was a rate, leave blank if it was 

an amount.
The following buttons are shown:
Apply Globally Automatically adjust the pay additions and deductions of all employees.
Apply Individually Adjust the pay additions and deductions one employee at a time and 

show the results of the pay review to allow changes to be made.
Cancel Abort the pay review and close the window.
Related Topics:

To automatically adjust all employees
To apply the changes but allow alteration for each employee



To automatically adjust all employees
1. Enter the changes to be made to pay additions and deductions.
2. Click the Apply Globally button to apply the amounts or rates specified.



To apply the changes but allow alteration for each employee 
1. Enter the changes to be made to the pay additions and deductions.
2. Click the Apply Individually button.
3. The Employee Pay Review window is shown.
4. If you agree the changes shown click the Save button. If you wish to amend the 

changes alter the figures and then click the Save button. If you want to ignore all 
changes and view the next employee click the Ignore button. Click the Abort button
if you wish to stop the pay review at this point.



Employee Pay Review
The Employee Pay Review window is shown if the pay review is done on an individual basis.
The following columns of information are shown depending on pay additions and deductions 
that apply for this employee
+/- + indicates a pay addition, - a deduction
Name Pay addition or deduction name
Calc Marked if the pay addition is a calculated field
Old Amount The currently held amount
New Amount Revised payment or deduction 
Difference The New Amount - Old Amount
% The percentage rate of change
Note that the amounts shown are for the nominated pay period, i.e. weekly, fortnightly, 4 
weekly or monthly. 
In the unusual circumstance that you pay some other multiple of weekly/monthly pay period 
e.g. bi-annually, then you will need to adjust the amount only if you paid an annual fixed 
amount increase/decrease. Percentage changes will be correct.
The following buttons are shown:
Save Save the changes and show the next employee.
Ignore Ignore the changes and show the next employee.
Abort Abort the pay review. Changes already saved will not be undone.



Automatic IDs
The Automatic IDs command in the Tools menu allows you to specify whether dbsPay2 will
automtically generate identifiers for employer, employee and departments or whether they 
are manually entered when adding new ones.
The following columns are shown:
Identifier One of employer, employee or department
Auto Mark the check box to have dbsPay2 automatically supply ids when adding 

the identifier concerned, leave empty if you are going to supply the 
identifiers

Range From The starting number for the automatic identifiers
Range To The ending number for the automatic identifiers
Last Used The last used number
The following buttons are shown:
Amend To change the automatic ids shown
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information

Related Topics:
To amend the automatic ids
To close the window



To amend the automatic ids
1. Click the Amend button and enter your changes.
2. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Change Security Levels
This allows changes to the security levels held for all menu commands.
The following information is shown for each menu item:
Command Command name
Level Security level between 1 (lowest) and 5 (highest)
The following buttons are shown:
Amend To change the security levels shown
Close To close the window
Save To save changes made to the information
Cancel To ignore changes made to the information

Related Topics:
To amend the security levels
To close the window



To amend the security levels
1. Click the Amend button and enter your changes.
2. Click the Save button to keep your amendments, or the Cancel button to ignore.



To close the window
1. Click the Close button.



Tidy command
The Tidy command in the dbsPay2 menu will recover any disk space. You should be the 
only user accessing the dbsPay2 database when using this command. 
Use this command periodically, e.g. every 6 months, to ensure that you are not wasting disk 
space.



Introduction
This section shows the answers to some typical payroll questions that Deverill Business 
Systems have been asked. 
Related Topics:

Bulk tax code change - How to apply?
Calculating Pay does not work - Why not?
Changing employees' pay frequency from Weekly to Monthly - How?
Company Cars and National Insurance - Class 1A
Employee becomes a director during the tax year - How to handle?
Holiday pay / Extra weeks payments - How to pay?
Leavers - How to handle employees that leave?
Legislation Changes - How are they handled?
National Insurance contributions for directors - How are they calculated?
Pay Periods other than Weekly or Monthly - How to handle?
Pay Rounding - How to handle?
Pension Schemes - How to set them up?
Pension schemes - How to reconcile the COMP amounts
Recovery of SSP
Reports are excluding some employees - Why?



Bulk tax code change - How to apply?
The Amend Tax Codes... command from the Tools menu allows you to increase or 
decrease all of your employee's personal tax codes to the new codes advised by the Inland 
Revenue. This normally happens once per year following changes announced in the budget.



Calculating Pay does not work - Why not?
Are you paying for the correct tax week? To check this, take a look at the Free Pay tables 
supplied by the Inland Revenue. You will find that the tables show which calendar dates 
relate to which tax weeks.
If you are paying for the correct tax week then check to see if your employee has already 
been paid using extra weeks for things like holiday pay? To check this, examine the paid to 
week/month field in the Year to Date window for the employee as this should be less than 
the tax week/month for which you are about to pay.



Changing employees' pay frequency from Weekly to 
Monthly - How?
Please ensure that you carry out this procedure at the beginning of a new month and not 
part way through a month as dbsPay2 is unable to adjust the NI contributions if part of the 
month was paid weekly and the remainder was paid as monthly.

1. Set the pay frequency to monthly in the Payroll General window for the employee.
2. Alter the SSP earnings in the previous eight periods on the SSP & SMP Window for this

employee. Set the -1 and -2 values to monthly amounts and the rest to zero.
3. Change the Current Pay Period amounts to reflect monthly amounts.
4. Set the paid to month number in the year to date window to the last completed 

month, not the month you are about to pay the employee for.



Company Cars and National Insurance - Class 1A
Class 1A National Insurance may be payable for employees who are classified as high 
earners (i.e. over £8,500 per year) or directors if you provide a company car for them.
For full details on how to calculate Class 1A NI refer to the following DSS guides:

NI269
CF391
CF392

To correctly calculate Class 1A NI you will need to work out which employees qualify for this 
contribution and then determine the scale charges that apply.
If an employee qualifies then you must ensure that the Class 1A NI check box is marked in 
the Pay window for the employee
Class1A NI is entered usually once per year in June. Use the Class1A NIC command in the 
Tools menu to enter the car and fuel amounts from the tables provided by DSS. This is done 
immediately prior to paying the staff for the pay period. Having paid the employees for the 
normal pay run the reports will reflect the company car NI.
If an employee leaves after you have paid the years class1A remember to pay them during 
the next tax year when Class 1A is due again if they used their company car after the last 
time you paid Class1A.



Employee becomes a director during the tax year - How to 
handle?
To ensure dbsPay2 calculates the director's National Insurance correctly you will need to 
treat the employee as a leaver and then create a new employee marking the director check 
box in the Personnel Details window. You must also enter the gross paid and tax paid in the 
Payroll General document and the remaining number of weekly paid periods left in the tax 
year    (even if monthly paid) must be entered in the director's pro-rata weeks field in the NI 
& Pension Window.
At the end of the tax year you will have two P14/60s for the director, one whilst an employee
and the other for the director period. You will need to consolidate the two P14/60's and also 
make an amendment to the P35 to reflect this.



Holiday pay / Extra weeks payments - How to pay?
You can pay one or all of your employees for any extra weeks in the normal pay period by 
using the extra weeks field in the Pay Input window. 
You will need to ensure that the amounts you enter reflect the number of weeks you are 
paying. For example, if the extra week is a holiday week, then use the holiday pay field to 
pay the earnings for the additional week or increase the normal wages or salary field.



Leavers - How to handle employees that leave?
On the employee's last pay day pay him/her as normal and produce the payslips and other 
reports. 
Once you have completed the normal pay run, enter the employee's date of leaving in the 
Personnel Details window and save the changes made. You can now print the P45 Details 
report for this employee. This report can then be transcribed onto the official P45 
documentation. In addition, you may need to complete an SSP1(L) Leavers Statement.
The employee will no longer be shown during pay runs but can only be removed during the 
end of year reset. Please note that you are required by law to keep employee details, in 
some form, for at least five years from the date of departure.



Legislation Changes - How are they handled?
The normal changes to bandwidths and rates announced in the Budget are catered for by 
amending the appropriate rates in the Tax, NI and SSP&SMP tables.
However, Deverill Business Systems are unable to predict all changes that may take place in
the future, and therefore offer you the facility to upgrade your dbsPay2 to the latest version 
for a fixed price. This facility is only offered to those customers who have registered their 
purchase with dbs by returning the registration document. Alternatively, you may choose to 
take out membership of the Customer Support Programme. Please refer to the details 
supplied with dbsPay2 for details of the Customer Support Programme options and costs.



National Insurance contributions for directors - How are 
they calculated?
Directors' NI contributions are calculated in a different manner from non-director employees.
The NI is calculated on the directors' year to date earnings and because of this the National 
Insurance earnings limits are also equated to the year to date figures. For example, if the 
lower weekly NI limit is £54.00, the director will not pay any NI until his or her earnings reach
the annual lower limit of £2808, (£54 x 52 weeks). Once the earnings have reached the 
annual lower limit the director will continue to pay NI in this manner until he/she reaches the
upper annual NI limit at which time NI for the director will cease, although the company will 
continue to pay employer NI.
To ensure that dbsPay2 calculates the NI contributions correctly, the following must be done:

1. Mark the director check box in the Personnel Details window.
2. Set the director pro-rata weeks box to the number of weeks in the tax year this 

person is to be a director. This should be 52 if the person is a director at the start of a
tax year.

For more detailed information on how Directors' NI is calculated please refer to the DSS 
document NI35 entitled 'NI for Company Directors'.



Pay Periods other than Weekly or Monthly - How to 
handle?
Fortnightly and    four weekly pay periods are catered for by:

1. Setting the employee to the appropriate pay frequency in the Payroll General window.
2. When paying the employees entering the tax week as the start tax week, i.e. use tax 

weeks 1,3,5,7,9.... for fortnightly paid, tax weeks 1,5,9,13,17..... for 4 weekly paid.
Other pay periods that are multiples of weeks can be catered for by:

1. Setting the employee to Weekly paid in the Payroll General window.
2. Use the extra weeks facility to adjust the pay period.



Pay Rounding - How to handle?
You can round the net pay that each employee receives to a multiple of the various coin 
denominations.

1. Select the amount to round to in the Pay Parameters window.
2. Mark the round net pay down check box if pay is to be rounded down or leave blank if

pay is to rounded up.
This will result in all employees' pay being rounded, with the amount that is added or 
deducted being shown on the payslip and other reports.
If the employee leaves your employment the final payment will still be rounded to the 
current rounding amount selected, and hence the employee will not be deducted/refunded 
the outstanding amount accumulated. If you wish to refund/deduct this amount then you 
should pay the individual his last pay run separately as follows:

1. Set the rounding amount to 1p on the Pay Parameters window.
2. Pay the employee individually.
3. Set the rounding amount back to its previous value in the Pay Parameters window.



Pension Schemes - How to set them up?
Pension schemes can have contributions for a fixed amount each pay period or a percentage
of any combination of additions and deductions from pay. The letter is achieved by:

1. Marking the pension column on the Addition and Deduction Names window as 
required.

2. Entering the percentage rate for employee and employer on the NI & Pension window
for each employee.

Different rates can be used for employee and employer contributions. 
The following will help you set up your employee pensions:

1. Is your Pension in a COMP or COSR scheme? If no go to step 7.
2. Do you want to deduct the COMP Rebate from employees pay?

If yes go to step 4.
3. Remove X from the deduct rebate from earnings in Pay Parameters window.

Go to step 5.
4. Insert X in Deduct rebate from earnings in Pay Parameters window.
5. NI Letter usually set to F for COMP schemes or D for COSR schemes in employee Pay 

window
6. Enter OPS Scheme number for COMP schemes e.g. 4999998A in the NI & Pension 

window.
7. Enter pension contributions fixed or % in NI & Pension window.
8. Select the pension type, COMP, COSR or Other in NI & Pension window.

The OPS Scheme number will be advised by the pension company. The scheme number tells 
dbsPay2 which type of pension scheme contributions are being paid into. The current range 
of OPS scheme numbers are 4000000 to 4499999 for salary related COSR schemes and 
4500000 to 4999999 for contracted out money purchase COMP schemes.
The NI letter will be advised by the DSS.



Pension schemes - How to reconcile the COMP amounts
The figures produced on reports when a COMP scheme is in effect can often be confusing 
and the following example is provided to assist with understanding. 
The example assumes the simplest case where, although a COMP scheme has been defined,
no specific additional contributions have been made and where a weekly wage of £200 is 
payable.
The overall payment summary report printed showed:
Salary 200.00 Income Tax 49.00

NI Employee 14.82
C/Out NI Employee 11.13
Pension employee 0.00
COMP rebate 3.18

TOTALS
Gross earnings 200.00 Taxable 196.82
Deductions 67.00
Rounding 0.00
Net Pay 133.00

DUES PAYABLE
NI Employee 14.82 Pension employee 0.00
NI Employer 14.85 Pension employer 0.00
Total NI 29.67 To pension fund 0.00
Income Tax 49.00 COMP minimum payment

9.22
Total Tax and NI 78.67
......
When a COMP scheme is introduced the employee becomes contracted out although the 
amount of the lower NI earnings limit still accrues at the contracted in rate. This is the 
normal source of confusion with the figures produced.
In the example, the NI Employee amount of £14.82 charged on earnings of £200 is a 
combination of £41.00 (the lower earnings limit in effect at the date of the example) at the 
contracted in rate and £159 at the contracted out rate.
The C/Out NI Employee amount of £11.13 represents the NI charged on the £159 at the 
contracted out rate which is included in the total NI Employee figure.
The COMP rebate amount of £3.18 is the difference between what the employee would have 
paid if NI had been calculated on the full £200 at the contracted in rate (i.e. £18.00) , and 
what was actually deducted (£14.82). The COMP rebate amount is transferred into the 
pension fund by the employer and, is normally deducted from the employee's earnings. 
However, there is a benefit to the employee in that this deduction is made before tax is 
calculated.
The COMP minimum payment of £9.22 is the difference between the sum of the employer's 
and employee's NI calculated at the contracted in rate (i.e. £18.00 + £20.89) and what was 



actually deducted because of the COMP scheme (i.e. £14.82 + £14.85). This difference, 
£9.22, is the minimum amount the employer must pay over to the pension scheme. 
Obviously, this amount would increase by any additional contributions that either the 
employer or employee makes.



Recovery of SSP
From 6th April 1995, a new method of recovering SSP was introduced. SSP is now only 
recoverable for all employers when the SSP Paid in an Inland Revenue returns period 
exceeds the total NI for the period excluding Class 1A multiplied by the SSP Reimbursement 
percentage, 13% for 1995-96.
For example if you paid £525 worth of SSP in period 6th April to 5th May, and the Total NI 
was £3672.18, then:

SSP Recovered = SSP paid - % of NI
= 525.00 - 3672.18 x 13 / 100
= 525.00 - 477.38
= 47.62

To see the SSP Recoverable view or print the Inland Revenue Returns.
 Note that the SSP Recoverable is calculated each time a pay run is made and so until you 
are ready to remit to the Inland Revenue the recoverable figure can change. The GL Posting 
report will record differences (if not monthly paid) as each pay period is closed, so for 
instance it may record 47.62 for the first period, and adjust this if the next pay period 
reduces or increases the ssp recoverable amount. Note that if using a departmental 
breakdown for the postings the SSP Non Recoverable fields will in total reflect the changes 
required, but individual department SSP non recoverable figures may look strange .



Reports are excluding some employees - Why?
Unfortunately, many factors can contribute to this problem, but the most common one is 
that the employees have been paid for an extra week, perhaps for holiday pay. 
For example, all employees are paid for week 17 but Jane Smith has been paid 1 extra week 
for holiday pay. The current period report for week 17 will include her, but the year to date 
report up to week 17 will exclude her. However, on week 18 she will be ignored from the 
current pay period report but will be included in the year to date to week 18.
If you wanted to see the year to date figures up to week 18 having paid week 17, then the 
year to date report should be printed up to week 18 and all employees will appear, though 
all of them except Jane would have been paid up to week 17.
Employees can also be excluded if you do not have the correct security level to see 
particular employees details. 



Glossary of Terms
COMP
COSR
EWC
MPP
NI
NIC
OPS
PIW
SMP
SSP



COMP
Abbreviation for Contracted Out Money Purchase. A type of pension scheme.



COSR
Abbreviation for contracted out salary related. A type of pension scheme.



EWC
Abbreviation for expected week of confinement



MPP
Abbreviation for Maternity Pay Period



NI
Abbreviation for National Insurance.



NIC
National Insurance Compensation. Used in conjuction with SMP to show what compensation 
is allowed for the National Insurance charged for SMP payments.



OPS
Abbreviation for Occupational Pension Scheme.



PIW
Abbreviation for period of incapacity to work.



SMP
Abbreviation for Statutory Maternity Pay



SSP
Abbreviation for Statutory Sick Pay



Macintosh users with a single button should hold down Alt and Command keys and then 
Click



This is only applicable if you have purchased the multi-company version of dbsPay2



You may wish to see the latest log by clicking the Log button so you can determine which 
diskset should be used



You may wish to see the latest log by clicking the Log button so you can determine which 
diskset should be used



SSP and SMP payments are not included here, they are automatically provided. 



Only mark this check box for items that change from pay period to pay period, e.g. overtime



WARNING Be careful changing the Calc column setting once employees have been set up 
with the pay addition in their information.



Income Tax, National Insurance and pension deductions are not included here as they are 
automatically provided.



Only mark this check box for items that change from pay period to pay period



Notice the code can not be changed. You will need to delete the department and add a new 
one to change the code.



If there are any employees assigned to this department then the deletion will not be 
allowed.



Account codes do not have to be set up if you don't want to use the GL Postings report or 
automatic posting to a general ledger



You should not need to alter these figures once they have been set before first paying your 
employees



You should not need to alter these figures once they have been set before first paying your 
employees



You should not need to alter these figures once they have been set before first paying your 
employees



You should not need to alter these figures once they have been set before first paying your 
employees



For holders of plastic NI cards, do not enter the two check digits



Up to 4 NI letters can be used in any one year. The current one is always shown first.



If you have payments to make for week 53, then you must pay week 52 first and print 
reports, and then pay week 53 separately



If you forget to set entitlement then use the Escape key to prevent the validation message 
stopping you from using the Cancel button



Use this to only choose employees who have been paid for the tax week specified



Use this to only choose employees who have been paid for the tax month specified



You should periodically delete no longer required reports held on the disk to save disk space



If you forget to set entitlement then use the Escape key to prevent the validation message 
stopping you from using the Cancel button



WARNING Amendments made here will not be reflected in employees pay



WARNING Amendments made here will not be reflected in employees pay



Pay reductions can be accomplished by preceding the amount or rate with a minus sign, e.g.
-1.5




